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1  Revision history

Product version Document Changes/comments

• FieldCare: 2.13.xx
• DeviceCare: 1.05.xx

KA01303S/04/A2/0
4.18

New product version
DeviceCare: new product version

• FieldCare: 2.14.xx
• DeviceCare: 1.06.xx

KA01303S/04/A2/0
5.19

New product version

• FieldCare: 2.14.xx
• DeviceCare: 1.07.xx

KA01303S/04/A2/0
6.20

New setups (new components)
DeviceCare: new product version

• FieldCare: 2.15.xx
• DeviceCare: 1.07.xx

KA01303S/04/A2/0
7.20

New FieldCare product version

• Software license management
• USB stick replaces DVD

• FieldCare: 2.16.xx
• DeviceCare: 1.07.xx

KA01303S/04/EN/
08.22-00

Section 4.3: Note on software update service

2  Document information

2.1  Document function
These instructions contain all the information needed to install and update the
software.

2.2  Symbols used

Symbol Meaning

Open the start page of the Installation Manager.

Open the language setting.

Additional information about the software.

Close the application.

Jump back to the last page opened.



Endress+Hauser 3

Symbol Meaning

Information about FieldCare, modem, Fieldgate, Field Xpert.

Open the keyboard.

Full screen.

Exit full screen.

3  Product description

3.1  Software function
The Installation Manager guides the user through the installation of all the
FieldCare components which are delivered within the FieldCare package (frame
application, driver, CommDTM-files, DeviceDTM-files, tools). Administrator rights
are needed to perform the installation.

3.2  Software License Management (SLM)

3.2.1  FieldCare SFE500 licensing model
FieldCare is delivered as a free trial version with a time limit. The license
agreement (EULA) is valid for use. If FieldCare is to be used permanently, it is
required to purchase FieldCare and activate the license using the Software ID
provided.

The FieldCare licensing model consists of a basic module called "Plant Asset
Management" (PAM) and an extension called "Condition Monitoring". A license
comprises a combination of the PAM module plus further extensions.

It is required to activate the license using the Software ID provided to use the
latest version of FieldCare. The license key of the previous version is no
longer usable for the latest version. For more information visit
www.endress.com/sfe500 or contact your local Endress+Hauser sales
partner.
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The software license management offers the following functions:
• Use of the software in trial mode for 60 days
• Activation of the software permanently (with or without Internet connectivity)
• Renewing the license
• Returning the license

Activating the software permanently
Prerequisites:
• The software is installed on the computer
• The license agreement (EULA) was accepted

Activating the software permanently with internet connectivity
Prerequisites:
The Software ID is available

The Software ID is located on the type plate of the USB box with the FieldCare
USB stick or in the e-mail that has been sent by Endress+Hauser on delivery.

1. Start the software.
 The window Software Activation is displayed:
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2. Click Activate Software.
 The window Software License Management for the Software ID entry

is displayed.

3. Enter the Software ID.
 A symbol confirms a correct Software ID.

4. Click Continue.

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5. If you already have a user account for the Endress+Hauser Software Portal:
Enter your e-mail address and password, then click Activate.
 If the activation was carried out successfully, the following window is

displayed:

6. If you do not yet have a user account for the Endress+Hauser Software
Portal, return to step 4 and click Create Account.

After activation, the license information can be displayed:
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1. Click Close.


The window displays all relevant information concerning License, Serial
Number, Licensee and more.

2. Click the cross symbol  in the upper right corner to close the window.
 The application FieldCare starts subsequently.

The Software License Management function can be opened via the
FieldCare menu Help and License information, if needed.
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Activating the software permanently without internet connectivity
If there is no internet connectivity for the computer, the license can also be
activated manually.

Prerequisites:
• A portable storage device, e.g. a USB stick
• A second computer with internet connectivity

Overview of the manual activation process

Computer with FieldCare,
but without internet
connectivity

USB
stick

Computer with internet connectivity

Window Software
activation - Manual

In Endress+Hauser Software Portal

Step 1

To do: Store License
request file (*.EHR) on USB
stick.

=> 1. Activation request

To do: Upload license request file
(*.EHR) from USB stick.

2. License activation/-update

Step 2 <= To do: Store license update file (*.EHU)
on USB stick.

To do: Import license
update file (*.EHU) from
USB stick.

Step 3

To do: Store license
confirmation file (*.EHC)
on USB stick.

=> 3. Confirmation of license activation

To do: Upload license confirmation file
(*.EHC) from USB stick.
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Detailed description
1. Carry out steps 1 to 4 as described in the chapter Activating the software

permanently with internet connectivity.
 The Software Activation window is displayed with the message Your

client/server is not connected with the Internet.

2. Click Manual activation.
 The window Software activation - Manual is displayed.
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3. Click Save below Step 1.
 The Windows-dialog Save as ... opens up.

4. Save the license request file (*.EHR)on a USB stick.

5. Take the USB stick to a computer with internet connectivity.

6. On this computer with internet connectivity, go to the Endress+Hauser
Software Portal: https://software-products.endress.com

7. Log in at the Endress+Hauser Software Portal.

8. Select the Activation/Update menu.
 The following screen is displayed:

9. At 1. Activation request click Upload.

10. Upload the license request file (*.EHR) from the USB stick.
 If the upload was successful, the following message is displayed: The

license request file has been successfully processed. Continue with
Step 2 in the Software activation - Manual window.
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11. Confirm the message with OK.
 The name of the activation file „*.EHU“ is displayed:

12. Click Save.

13. Save the license update file (*.EHU) on the USB stick.

14. Take the USB stick to the computer which has the FieldCare application
installed without internet connectivity. Please note: Do not log out of the
Endress+Hauser Software Portal yet. On the computer without internet
connecitivity, the Software activation - Manual window is still on display.

15. Below Step 2 click Import.

16. Upload the previously saved license update file (*.EHU) from the USB stick.

17. Below Step 3 click Save.
 The Windows-dialog Save as ... opens up.

18. Save the license confirmation file (*.EHC) on the USB stick.

19. Click the cross symbol  in the upper right corner to close the window.
 The application FieldCare starts subsequently.

20. Take the USB stick to the computer with internet connectivity. The Endress
+Hauser Software Portal log in is still active.
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21. Scroll to 3. Confirmation of the license activation.


22. Click Upload.

23. Upload the saved license confirmation file (*.EHC) from the USB stick.
 If the upload was successful, the following message is displayed: The

software activation has been successfully confirmed.
24. Confirm the message with OK.

FieldCare is now permanently activated. The license status and license details can
be checked on the Endress+Hauser Software Portal at Products.

Updating the software license
Prerequisites:
• The software is installed on the computer
• The software is licensed
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1. Open the Software License Management function via the FieldCare menu
Help and License information.
 The following window is displayed:

2. Click the button Renew License.
 The window Access Software Portal is displayed.
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3. Enter your E-mail address and password, then click Renew License.
 If the activation was successful, the following window appears:

4. If you do not yet have a user account for the Endress+Hauser Software
Portal, go back to step 2 and click Create Account.

Return the software license
Prerequisites:
• The software is installed on the computer
• The software is licensed
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1. Open the Software License Management function via the FieldCare menu
Help and License information.
 The following window is displayed:

2. Click Return License.
 The window Access Software Portal is displayed.

3. Enter your E-mail address and Password, then click Return License.
 If the return was successful, the Return License window appears with

the message: The software was successfully returned.
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4  Installation
Some components take a long time to install. To avoid problems, do not
cancel the installation unless requested to do so.

4.1  System requirements
Prior to installation, install the necessary software, e.g. Microsoft.NET
3.5/4.x and PDF Reader.

In the database mode, FieldCare versions up to 2.10.xx use SQL Server 2008 for
data archiving. FieldCare versions from 2.11.xx are compatible with Windows 10,
provided that the database is updated at least to SQL Server 2014.

Installation and update scenarios supported by version 2.15.xx:

Installed
operating
system

Installed SQL
Server

FieldCare
database  1)

FieldCare Procedure

Windows 10 No No Not installed • Install FieldCare
2.15.xx incl. SQL
Server 2014

• Install FieldCare
database.

Windows 10 SQL Server
2014 or SQL
Server 2016

No Not installed • Install FieldCare
2.15.xx.

• Use existing SQL
Server.

• Install FieldCare
database.
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Installed
operating
system

Installed SQL
Server

FieldCare
database  1)

FieldCare Procedure

Windows 8.1 -
10

• No
• SQL Server

2008

No Not installed • Install SQL Server
2014.

• Install FieldCare
2.15.xx.

• Install FieldCare
database.

Windows 8.1 -
10

SQL Server
2008

Yes • Not installed
• Older version

of FieldCare

• Install FieldCare
2.15.xx.

• Use existing SQL
Server.

• Use existing FieldCare
database.

1) The SQL Server contains a database that can be used by FieldCare for data archiving.

The FieldCare setup does not support an installation that involves upgrading
the Windows version.

A pre-installed SQL Server is not updated automatically during a Windows
upgrade. If SQL Server 2012 or older is installed, it will no longer work following
the upgrade and neither will any pre-installed applications that require an SQL
Server.

1. Make a backup of the FieldCare database in the SQL Server, the DB backup
and the user files.

2. Upgrade installed Windows version to Windows 10.

3. Install FieldCare with SQL Server 2014.

4. Restore the data that were backed up previously.
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4.2  Installing the software
1. Insert the FieldCare USB stick into a USB port and navigate with the

Windows File Explorer to the root folder.

2. Start the FieldCare installation program (InstallationManager.exe).


Options on the Installation Manager start page:
• FieldCare SFE500 installation →   18
• DeviceCare SFE100 installation →   21
• DTM library installation →   22
• More →   25

4.2.1  Installing FieldCare SFE500
1. Click FieldCare SFE500 on the Installation Manager start page.

 The "EULA" tab opens.



Endress+Hauser 19

2. Select I agree to accept the license agreement and click Next.
 The "Path" tab opens.
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3. Select the installation path and click Next.
 The "Install" tab opens and FieldCare is installed.

Following installation, the "Report" tab opens.

4. Close the dialog box.

The database password must be changed following successful installation of
FieldCare. It is not allowed to use the standard database password.
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4.2.2  Installing DeviceCare SFE100
1. On the Installation Manager start page, click DeviceCare SFE100.

 The "EULA" tab opens.

2. Select I agree to accept the license agreement and click Next.
 The "Path" tab opens.
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3. Select the installation path and click Next.
 The "Install" tab opens and DeviceCare starts to install.

Following installation, the "Report" tab opens.

4. Close the dialog box.

4.2.3  DTM library
To be able to access the devices, the required DTMs and DTM libraries must
be selected and installed.
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1. Click DTM library on the Installation Manager start page.
 The "Welcome" tab opens.

2. Accept the license conditions and click Next.
 The "System" tab opens.
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3. Click Next.
 The "Selection" tab opens.

4. Select the products that need to be installed and click Next.
 The "Overview" tab opens.
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5. Click Install.
 The DTM library starts to install and displays a message to confirm that

installation was successful.

6. Click Close.
 The start page of the Installation Manager opens.

4.2.4  More
‣ Click More on the Installation Manager start page.

 The dialog box with the selection options opens.
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DTM library
‣ Click DTM library.

 All available DTMs are displayed.

Communication DTMs
‣ Click Communication DTMs.

 All available Communication DTMs are displayed.
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Documentation
‣ Click Documentation.

 All documents are displayed as PDFs.

Drivers
‣ Click Drivers.

 All available drivers are displayed.
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Tools
‣ Click Tools.

 The installation process for the Envelope Curve Viewer starts.

4.3  Updating the software
Endress+Hauser offers an update contract for FieldCare.

Contact your Endress+Hauser sales partner for further information.

Software update service
The inclusive maintenance period starts with the creation of the license and
ends automatically after one year (expiry date). Regardless of when the
software update service is purchased, any additional software update service
purchased will continue without interruption from the last expiry date. If
purchased after the expiry date, the new maintenance period will initially
cover the gap in service created between the expiry date and the creation of
the purchased software update service.

It should also be noted that software updates can also be activated at a later
point in time, provided that the software release was issued within a valid,
active maintenance period.

Subscribing to product information
1. Enter https://software-products.endress.com in the web browser.

2. Log onto the Software Portal.
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3. In the Software Portal, click My account.
 The "My account" dialog box opens.

4. Scroll down, select I agree to receiving marketing communication
information like available updates from Endress+Hauser and click Save.
 You have subscribed to product information.

4.4  Updating DTM catalog
The FieldCare DTM catalog must be updated after installing new DTMs.
Administrator rights are needed to do this.

Prerequisites:
• FieldCare has been installed
• The Software-ID has been entered and the software has been activated
• The DTMs have been installed

1. In FieldCare, click DTM Catalog and Update.
 The "Update DTM Catalog" dialog box opens. The window on the left

shows the DTMs that are not included in the DTM catalog. The window
on the right shows the DTMs that are included the DTM catalog.

2. Click Update.
 The installed DTMs are updated.

3. Using the right mouse button, click the left window and select Add all to
DTM catalog.
 The DTMs and iDTMs are added to the DTM catalog.

4. Click OK.
 The changes are accepted and the dialog box closes.
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